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ABSTRACT 
 

Erosion and flooding in the Cusco watershed have increased over the last 30 years due to 

urban growth and incorrect use of natural resources. New data for a section of the 

watershed were created with satellite image, spatial data, and geoprocessing software 

including Erdas Imagine 9.1 and ArcInfo and free information and software in the public 

domain on the internet. AGWA2.0 – SWAT modeling software used the data to assess 

the actual conditions of the study area (Model 1) including sediment yield, water yield, 

percolation, and stream flow. Then, two models were created by altering the conditions of 

the land cover/use grid: Model 2 changed the bare soil class into contour trenches, and 

Model 3 changed bare soil class into trees or forest. A comparison of Models 2 and 3 

with the current state (Model 1) found that forestation, Model 3, would greatly decrease 

flooding and increase water infiltration. 
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CHAPTER I  INTRODUCTION 
 
 
1.1 Problem Statement 

The problem that will be addressed in this study has three parts: 

 

1. Given the lack of resources, Cusco has never had a watershed assessment, and as 

a result, does not have a comprehensive plan for watershed management in order 

to reduce flooding and increase infiltration rates. Furthermore, Cusco does not 

have the knowledge base to apply the latest modeling tools using spatial data and 

GIS software. 

 

2. For similar resource issues, there is a lack of knowledge of how these models can 

be applied to Andes region. Applying these tools in the Cusco Watershed 

provides information regarding their utility in these areas. 

 

3. There is also a bureaucratic challenge of acquiring data from Cusco’s weather 

station. 

 

1.2 Research Objectives  

The principal objectives of this research are:  

1. Obtain key climate data for the study area watershed by accessing information 

available in the public domain on the internet and generate new, highly accurate, 
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land cover data using remote sensing and GIS technology (ArcGIS 9.x, Erdas 

Imagine 9.1, Google Earth, and Zonuum Solutions) with a satellite image and 

field survey;  

 

2. Use the Automated Geospatial Watershed Assessment tool (AGWA 2.0) with the  

Soil and Water Assessment Tool (SWAT) (Miller et al. 2007) to assess the current 

conditions of the study area watershed as well as generate and analyze possible 

scenarios of land cover/use changes impact on water and sediment yield and water 

infiltration rates;  

 

3. Develop recommendations based on the results of objective 2, for a land use plan 

of action to reduce flooding and increase water infiltration rate, especially in areas 

where the aquifers are located, as exploration into how GIS technology can be 

used for natural resources planning and management in the Andes 
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CHAPTER II  LITERATURE REVIEW  

 
 

There are many articles and published papers related to the topics of this thesis. Three of 

the most related articles are presented here.  

 
2.1 A GIS Process for Delimiting Areas Potentially Endangered by Debris Flow By  
      Fan-Chien et al. (2006)  
 

Problem Statement 

Natural phenomena like debris flow, landslides, avalanches, and lava create hazardous 

zones especially if they are located close to any kind of human activity. Typhoons 

accompanied by severe winds and rainstorms are the principal factors for debris flow 

generation in the south of Nantou County in central Taiwan.  

 

Objective  

The principal objective of this research was to create a model that could be used for 

delineating potentially hazardous zones associated with debris flow in rivers in Taiwan. 

This research was developed in the Chen-You-Lan watershed which is located in the 

southern Nantou County in central Taiwan. The watershed area is 450 km2, and the only 

way to get to this area is via a expressway. Nine pilot sub-watersheds were investigated 

to determinate the debris flow dynamics.  
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Data Requirements 

A micro-geomorphological analysis was conducted using aerial photographs and digital 

terrain models (DTM). The digital elevation differences between 1993 and 1996 aerial 

photos (before and after the typhoon) show the areas affected by the natural event 

(erosion, transport and deposition) 

 

Procedure and Techniques 

The disasters created by the Typhoon Herd in 1996 in Taiwan and the debris flow caused 

by this phenomenon were the principal causes which inspired the authors to conduct this 

investigation. The authors chose nine pilot sub-watersheds and then described each sub-

watershed using aerial photographs which were taken before and after the typhoon. The 

most important photographs were the ones showing the debris flow characteristics 

generated by the typhoon (landslide, overflow, and deposit areas). The descriptions of the 

study area were based in the geomorphology, geology, hydrology, and etc. They sampled 

some soils, in the deposit zones, for laboratory testing so they could have the engineering 

properties of the debris mixture in the watershed. In addition they also used the rainfall 

history from July 31 to August 1, 1996.  This event had recorded a peak in rainfall 

intensity which occurred at 3:00 A.M. on August 1st with 70 mm/hr and a maximum 

accumulative rainfall of 1600 mm (outside the watershed). The local geology was 

described based on the general characteristics of rock formations and their compositions, 

and also faults were included as part of the structural geology in the watershed. 
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A statistical and regression analysis was developed in order to create a formula which 

explains the debris flow horizontal distance and its area of influence.  The formula was 

based on the volume of the debris mixture, where Hmax is the maximum difference in 

altitude (between the landslide scarp and the very far deposited debris) and the Lmax 

(corresponding horizontal distance). 

 

Flow Diagram 

This field-based model was developed using all the information available and generated 

by the debris flows in the nine pilot sub-watersheds. All the data obtained, such as 

landslide characteristics (erosion, transport and depositional area) and its measurements 

as well as pre- and post- 1996 typhoon aerial photographs were used to create formulas 

that could help us to understand the debris flow behavior. The following flow chart 

(Figure 1), used by the authors, shows the GIS delineating steps and helps to understand 

this research process. 
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Figure 1 Flow chart delineating GIS procedure used in A GIS Process for Delimiting 
Areas Potentially Endangered by Debris Flow (2006) 
 

Calculation affected areas by eqn. (2) 
And allow user to input definitive value  

Selection de zones by gradient  
Order of sampling points 

Suggestion of the user 
amplifying the scanning radius 

Connection the zones of gradient > 0  
Matching the affected area 

First approximated zoning 

Finally delineated potentially endangered 
areas 

Selection sampling density by DTM precision 

Input scanning fan shape angle 
Calculation fan radius by eqn (1) 

And allowing user input a definitive value 

Input debris mixture volume 

Delineation flow direction 

Limitation de areas by other 
modified conditions (curvature, 

gradient, flow direction confined) 
(second modified zone) 

Definition the overflow points  

Collection coordinate and 
elevation of overflow points   

Calculation azimuth  

Input DTM and topographic map 
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Results 

The results are maps within delineated debris flow hazard areas, and the overflow points. 

This investigation also confirms the importance of the regional topography in the process 

of delineation endangered areas by debris flow. 

 

Conclusions  

The use of GIS and other software like Flo-2D and micro-geomorphology analysis, as 

instruments for generating models that could help watershed managers describe and 

understand natural events like landslides, debris flow, avalanches, lava, and etc, is in 

development. The use of GIS in this research gives a better approach for debris flow 

hazard zoning than previous ones.  

 

This article demonstrates how the use of GIS as an instrument for the analysis of natural 

events can give us a better approximation to reality, but we need to figure out how to do 

it. The researchers could have used more parameters that affect the process of debris flow 

in their calculations, including precipitation. They could also have included the 

characteristics of the areas where the materials came from, the rocks alterations grade, 

and the influence of vegetation coverage. These aspects are complex but they are part of 

this process. 

 

The next step in this kind of research should be to create models that could work with 

more of the factors involved in the process of natural events so that better and more 



20 

accurate maps can be generated to show the probable hazard areas in a debris flow event 

and prevent damage caused by this natural phenomenon.      

 

2.2 Exploration of Participatory GIS in Three Andean Watersheds By Ficenec 
(2003) 

 
Problem Statement 

This article is a brief analysis of the use of GIS technology in natural resources 

management and its influence in isolated regions of the Andes.  This application of GIS 

also includes a focus on social changes.  One of the most important opportunities in 

South America in the last few years is a political movement towards decentralization 

which is focused in local self government. Within this, GIS is playing an important role 

integrating natural resources management, technology and technicians, the affected 

population and nongovernmental organizations (NGOs) – stakeholders –in the project. 

 

Objective of the Research Study 

The article is focused on GIS in three small watersheds of the Peruvian Andes. Two of 

them – San Pablo (4240 ha) and La Asuncion (8515 ha) – lie in the upper Jequetepeque 

basin of northern Peru. The third and largest one - Mañazo (26915 ha) - lies in the 

southern highland department of Puno near Lake Titicaca.  Each project was 

administered by a local NGO in coordination with “Consorcio Para Desarrollo Sostenible 

de la Ecoregion Andina” (CONDESAN), a national NGO.  The local NGOs were staffed 

by engineers and an agronomist who worked closely with the stakeholders to collect the 
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secondary data and create soil and water georeferenced maps. None of these 

professionals had used GIS software before this project. The sole intended client of the 

GIS products was the Proyecto Nacional de Manejo de Cuencas Hidrograficas y 

Conservacion de Suelos (PRONAMACHCS) which is a national government program 

committed to soil and water preservation, especially in the Andes of Peru.  

 

Data Requirements 

The project used two data sources. For the secondary data analysis, the NGOs were 

provided with a full-time license for geographic modeling and image processing. For this 

process, the NGO’s staff was trained and supervised by a GIS specialist, and also during 

this process each NGO acquired hard copy topography maps, soil survey and land use 

data, then they scanned and digitized the maps. Finally, they used IDRISI (is an 

integrated GIS and Image Processing software solution providing modules for the 

analysis and display of digital spatial information) to interpolate the contours into a 15 m. 

resolution Digital Elevation Model (DEM).  The DEM information was used to create 

three themes: watershed boundaries, watershed agro-ecological zones based on the 

elevations, and the average slope. All this information provided the minimum necessary 

data sets for biophysical analysis across the watersheds. The final products were many 

thematic maps such as a map of pasture suitability for cattle, sheep, and alpacas 

according to vegetation associations from a land cover survey.  
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Procedure and Techniques 

The participation of the stakeholders was key in the collection of primary data through 

participatory resource mapping (PRM) and participatory rural appraisal (PRA) commonly 

used all over the world.  Large scale orthorectified aerial photographs were used for 

linking PRM and GIS and played an important role in the intercommunication between 

researchers and the community.  GPS was used for acquiring data in areas without aerial 

photography coverage. With the cooperation of local farmers they registered coordinates 

for principal infrastructures and features like boundaries, irrigation channels, villages, 

vegetation coverage, and etc.  The final product was a geodatabase with all the collected 

feature information from each area. The quality and quantity of the information was 

based on the stakeholders’ interest and enthusiasm.  

 

The social organization was one of the most important aspects of this project where the 

NGOs and their experiences helped the stakeholders be involved in the project. Each 

NGO and the stakeholders, using the GIS, created thematic maps focused on soil and 

water conservation. The final goal was that these products would help the stakeholders 

find or attract some financial support to develop their local projects. Figure 2 shows a 

flow chart outlining their process. 
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Figure 2 Procedural flow chart of Exploration of Participatory GIS in Three Andean 
Watersheds  
 

Results 

The principal results from this experience are the introduction of the GIS for the 

assessment of natural resources and the beginning of data collection for future processes 

using GIS modeling.   

 

Conclusions  

The introduction of new technology like GIS for natural resources management in rural 

areas like the Andes in Peru is a big jump to the new modern era. Because of the lack of 

knowledge in computer skills, it is very difficult to involve stakeholders in these kinds of 
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issues, but with the assistance of engineers and technicians with a basic knowledge in 

computers skills it is possible.  

 

This article is very important because it demonstrates that it is possible to work in any 

part of the world with GIS for natural resources management.  The data collection 

process can be greatly limited by the lack of information in soil use or soil classification 

or in boundary delimitations, but these issues can be solved with the help of the 

stakeholders with training.  Another limitation can be the access to the software because 

of its cost and also the access to a modern computer capable of running the software. 

 

It is also important to highlight that projects like these would be impossible without the 

interest and hard work of the local stakeholders.  In choosing sites, it is critical to start in 

communities with a great deal of interest and willingness to work. These sites then serve 

as examples to other communities who then see the benefits and organize to participate in 

future applications of the project.    

 

2.3 Putting Natural Resource Management on the Map: Using GIS as a Tool for Soil 
Conservation Planning in Two Small Andean Watersheds by Posner (2000) 

 
Problem Statement 

Limited knowledge and experience in watershed and natural resources management are 

principal factors of the degradation of the natural resources in the Andes. 
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Objective of the Research Study 

The objective of this research is the introduction of new technology, like GIS software 

and hardware available today, to help stakeholders in collect natural resource information 

and combine them to visualize their relationships in the watershed context. In this project 

maps were prepared and modified according to their specific purpose. The project was 

developed in a cooperative effort by the Cajamarca office of the Peruvian Proyecto 

Nacional de Manejo de Cuencas Hidrográficas y Conservación de Suelos 

(PRONAMACHCS), the non-governmental organization Asociación para el Desarrollo 

Rural de Cajamarca (ASPADERUC), municipal authorities of La Encañada and 

Asunción, and the International Potato Center (CIP). CONDESAN (Consorcio para el 

Desarrollo Sostenible de la Ecorregión Andina) sponsored the project.  

 

The study area is located in northern Peru in the Cajamarca Department. They first 

started with a small watershed within the municipality of La Encañada (15,700 ha) and 

then added one in Asunción (8100 ha). 

 

Data Requirements 

Since the principal goal of this study was to develop a database for multiple uses, the first 

outputs were maps with zones for soil conservation interventions that could be used by 

PRONAMACHCS, the national soil and water conservation agency, and the 

beneficiaries. It was assumed that slope, ground cover, soil type, and rainfall intensity 

were the most important factors to consider in the data base. They also digitalized 
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contour lines (for the DEM). Aerial photographs and preexisting soil maps (hard copies) 

were used for creating digital land use maps. Addition information, like solid properties, 

was collected by digging soil pits. 

 

Procedure and Techniques 

First, contour and stream lines were digitized and interpolated in order to create the 

digital elevation model (DEM). This information was used to subdivide the watershed 

into catchments and to make a slope map. Ground cover and soils maps were then drawn 

using aerial photos and existing soil maps. Based on this work, slope classes, ground 

cover classes, and soil depth units were defined. Political boundaries between 

communities, roads and paths, and local reference points (clinics, schools, and churches) 

were also georeferenced and included in the GIS database.  

 

An important aspect of this research was the level of teamwork employed.  The work was 

shared among individuals and institutions. For example, the GIS work for La Encañada 

was completed at the International Potato Center using existing databases developed for 

other projects (De la Cruz et al. 1999).  For Asunción, ASPADERUC scanned the maps 

for importing into Autocad, where the features of the map were digitized on screen. 

Additional landmarks were georeferenced with a global positioning system (GPS). Data 

were imported into IDRISI. The stakeholders cooperate with the filed collection data like 

digging pits, and mapping land uses. 
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The following Table 1 was used for the analysis of soil conservation, in collaboration 

with the PRONAMACHCS team. A set of rules was established to identify potential soil 

conservation interventions (no intervention, sloping terraces, infiltration ditches, and 

reforestation) on cropped land where the principal factors were the soil depth and 

potential erosion.  

Table 1 Analysis of soil conservation used in by the researchers and PRONAMACH in 
Putting Natural Resource Management on the Map: Using GIS as a Tool for Soil 
Conservation Planning in Two Small Andean Watersheds 
 

 

 

Figure 3 is a flow diagram showing the whole procedure applied in this research. It starts 

with the digitalization of the principal features for the data base, then  continue by 

creating DEM, slope classes, ground cover, soil depth, erosion, political division, 

reference points, etc  and combining all of then to ended up with a proposal at a 

community level.  
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Figure 3 Procedural flow chart designed for Putting Natural Resource Management on 
the Map: Using GIS as a Tool for Soil Conservation Planning in Two Small Andean 
Watersheds 
 

Results 

Given of the lack of information, especially geospatial data, GIS software was used to 

build a geodatabase for the stakeholders of la Encañada and Asuncion and 

PRONAMACH in order to use this new technology to analyze their natural environment 

and identify key problems as well as their solutions. One of the principal results from this 

study is the implementation of a database for future uses by institutions like 
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PRONAMACH and the beneficiaries of La Encañada and Asuncion.  Another important 

result is that more local organizations like government agencies, NGOs, universities, and 

professionals involved in natural resources issues are acquiring the software and getting 

new experiences to improve the methodology used in those two watersheds.  

 

Conclusions  

The introduction of new technology, (software and hardware), and new methodology 

(GIS Modeling) in areas like the Andes, is an important contribution for the development 

of the small urban areas and preserve the natural resources. The products from this 

process, such as digitized maps and georeferenced additional field measurements, would 

result in useful databases for natural resource management, soil and water conservation 

for present and future users.  
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CHAPTER III  BASIC INFORMATION AND METHODOLOGY 

 

3.1 Study Area 

The department of Cusco located in southern Peru near the Vilcanota Valley (The Sacred 

Valley of the Inca), is one of the most important departments in Peru. Its capital, the city 

of Cusco, has a population of about 360,000, which is three times its population 20 years 

ago. Its altitude is around 3,300 m (10,800 feet). Upon the arrival of the Spanish 

conquistadors, the Quechua (Indian) name ("Qosqo") was transliterated into Spanish as 

"Cusco". Cusco carries the title of the archeological capital of America with pride, 

because there is no other place on the continent where one easily can reach ruins of such 

an amazing culture which are still in a good condition including Machupicchu, 

Sacsayhuaman, Pisac, Tambomachay, Choquequirao, Ollantaytambo, Tipón, and others. 

 

The Huatanay River is the principal river system in the watershed.  It collects all surface 

water including waste water, rain water, seasonal, and perennial water. The continuous 

expansion of the city is increasing the impervious areas that reduce soil absorption and 

increase runoff including buildings, roads, and cement based public recreation areas, such 

as basketball courts 

 

The 74.6 km2 area for this study is in the Western side of the Cusco watershed, 

comprising the Saphy, Puquin, and Huancaro sub-watersheds.  The lowest altitude is 

about 3300 m (10,800 feet) and the highest altitude is about 4400 m (14436 feet). 
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3.1.1 Location 

The Cusco watershed is located in the Andes in southern Peru. (Figure 4) 

 

 
Figure 4 Location map of South America with Peru and its departments highlighted, 
pullout map of the department of Cusco (in red), and pullout map of the study area 
watershed in Cusco, Peru  
 

3.1.2 Accessibility  

There are three ways to access to Cusco watershed – by car, plane or train. There are two 

main roads in and out of the area – one that goes to Arequipa and Puno (South and East 

of Cusco) and one that goes to Abancay (West of Cusco) which continues to the coast 

and Peru’s capital, Lima. Cusco’s airport enables access by plane. There is also train 

service from Arequipa and Puno.  
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3.1.3 Weather 

Since Cusco is high in the Andes and close to the equator, the weather is relatively cool. 

The annual average temperature ranges between 10.45° and 12.55° Celsius. Usually, it is 

cold at night through the early morning and the temperature reaches its highest point in 

the early afternoon. In June, the temperature at night is frequently between -5° to 7°C. 

There are two well-defined seasons: a dry season and a rainy season. The dry season is 

typically May to October and the rainy season lasts from November to April. In general, 

the total annual precipitation fluctuates between 588 to 1020 mm.  

 

3.2 Data Collection 

Modeling a watershed with AGWA 2.0 requires climate data.  Data was obtained from a 

variety of sources including the National University of San Antonio Abad of Cusco 

(UNSAAC) who hosts the closest weather station to the study area watershed, Perayoc 

weather station. Some of the data needed for the modeling was impossible to get directly 

from UNSAAC or the local city government due to bureaucratic challenges, however, these 

data were able to be obtained from internet websites in the public domain. The satellite 

imagery was obtained from Digital Globe Inc. The topographic data was obtained via web 

pages including Google Earth and Zonum Solutions. The ground control points were 

collected by using a Garmin GPS eTrex receiver.  
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3.2.1 Climate Data (Perayoc Station) 

The Perayoc Meteorological Station was installed in 1953 on the campus of the National 

University of San Antonio Abad of Cusco on Avenida de la Cultura approximately 2 km 

from downtown Cusco which is very close to the study area watershed. The geographical 

location in UTM is: 

 
Latitude: 8503123 m 

Longitude:  179384 m 

Elevation: 3260 meters above the sea level. 

 
Data collected by this weather station includes: 
 

• Precipitation in mm 

• Temperature in °C 

• Humidity in % 

• Evaporation in mm 

• Atmospheric pressure in mmHg 

• Daylight hours 

• Wind direction and velocity in km/hr 

 

While data was obtained from the Perayoc weather station, bureaucratic challenges made 

it impossible to gain authorization to use them officially in this research. As such, the 

data used in this research was obtained from websites in the public domain. For example, 

daily precipitation (mm) and daily max and min temperature (°C) were obtained from the 
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web site http://clima.meteored.com/clima-en-cuzco-846860.html. When these data were 

compared to those of Perayoc weather station, they coincided almost exactly. So, while 

the data might not be from the official weather station they have almost the same 

information and were probably obtained from another weather station nearby in Cusco. 

Additional weather data like dew point, humidity in %, evaporation in mm, atmospheric 

pressure in mmHg, daylight hours, and wind direction and velocity in km/hr were found 

on the Internet in several web pages including: http://www.amarjoshi.com/man.html and 

http://www.seanet.com.  

 

3.2.2 Satellite Imagery 

The license for the QuickBird Digital Satellite Imagery (Figure 5) was obtained from 

“DigitalGlobe, Inc.” This license is only for educational purposes.  Any non-commercial 

study or research that is undertaken solely in furtherance of education and not for 

commercial exploitation.   
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Figure 5 Satellite image of study area watershed including subwatersheds delineated in 
red 
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QuickBird is a high-resolution commercial earth observation satellite, owned by 

DigitalGlobe and launched in 2001 as the first satellite in a constellation of three 

scheduled to be in orbit by 2008. QuickBird collects the highest resolution commercial 

imagery of Earth, and boasts the largest image size and the greatest on-board storage 

capacity of any satellite. The satellite collects panchromatic (black & white) imagery at 

60-70 centimeter resolution and multispectral imagery at 2.4- and 2.8-meter resolutions. 

The imagery used in this research is high resolution where the pixel size is 0.6 m. At this 

resolution, it is easy to see cars on the streets, and small patches of shrubs.  

 

3.2.3 Topographic information 

The topographic data was obtained by using different web pages available on the Internet.  

• First, about 10,000 points were sampled using the “Terrain” option on the 

“Zonum Solutions” web page (http://www.zonums.com/gmaps/terrain.html). 

The sampled points are described by latitude and longitude in decimal degrees 

and elevation in meters.  

• Second, the collected points were entered into Excel spreadsheets so it would 

be easy to select the points with errors, such as points with zero values in 

altitude, and check if there are any other data errors. 

• Third, the points were saved in a text file so they could be imported into the 

GIS environment (Figure 6).  
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Figure 6 Collected points (x,y, and z coordinates) with topographic information of the 
study area watershed using Zonum Solutions “Terrain” option that were then saved into a 
text file and imported into ArcGIS 9.2.  
 

• Then the points were transformed into a shape file format so it could be 

interpolated using the Spatial Analysis tool in the Arc tool box. 

• The final product is contour lines of the study area watershed, an sample 

section of which is seen in Figure 7.  
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Figure 7 Sample section of map with contour lines in 10m interval of the study area 
watershed 
 
 

• It was also necessary to create a drainage shape file with the purpose to 

generate the Digital Elevation Model (DEM) 

 

3.3 Software  

Erdas Imagine 9.1, ArcGIS 9.2, and AGWA 2.0 - SWAT software tools were used to 

analyze all the information for this research. This study provides a basic methodology 

that can be used for future studies, to expand the study to the entire watershed, or in 

another watershed with similar characteristics. 



39 

3.3.1 Erdas Imagine 9.1 

ERDAS IMAGINE is an image processing software designed by Leica Geosystems 

Geospatial Imaging. The latest version is 9.1. It is aimed primarily at geospatial raster 

data processing that allows the user to display and enhance digital images. It is a toolbox 

allowing the user to perform numerous specific classes of operations on an image and 

generate answers to specific geographical questions, such as: what kind of land cover is 

in the study area, what kinds of changes in the land use (e.g. urban areas) have occurred 

in the last 10 years, how does vegetation cover change yearly, and how is the health of 

the farm crops? 

 

By manipulating data placement in imagery it is possible to see features that would not 

normally be visible, such as: vegetation stress, thermo radiation, climate change on 

glaciers, and mineral deposits. The level of brightness or reflectance of light from the 

surfaces in the image can be helpful with vegetation analysis, and prospecting for 

minerals. Other usage examples include linear feature extraction, generation of 

processing chains ("models" in Erdas Imagine 9.1), import/export of data for a wide 

variety of formats, ortho-rectification of data and so forth. 

 

3.3.2  ESRI ArcGIS 9.x 

Geographic information system (GIS) is a collection of hardware and software used or 

the input, storage, analysis, and display of geographic features. In addition, GIS is one of 

a range of applications that work with spatial information where the costs of data 
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development and analysis constitute major costs in most GIS projects. Geographic 

information system technology can be used for scientific investigations, resource 

management, asset management, environmental impact assessment, urban planning, 

cartography, criminology, history, sales, marketing, and logistics. For example, GIS 

might allow emergency planners to easily calculate emergency response times in the 

event of a natural disaster, GIS might be used to find wetlands that need protection from 

pollution, or GIS can be used by a company to site a new business to take advantage of a 

previously underserved markets. 

 

3.4 Geology and Hydrogeology  

The Cusco watershed has geology units which vary from the Upper Paleozoic, such as 

the Mitu Formation, to the present quaternary deposits such as the San Sebastian 

Formation. There are five formations in the study area (Figure 8). The Kayra formation is 

the most important unit in the study area; the oldest is the Yuncaypata group.   
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Figure 8 Map of the study area showing the five geologic formations  
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3.4.1 Geology units and its hydrogeology characteristics 

Yuncaypata Formation (Albiano – Maestrichtiano) 

The Yuncaypata Formation (Figure 9) is characterized by multicolor shale and mudstone 

(Detrital sedimentary rocks made up of silt- and clay-sized particles). The Yuncaypata 

group also has blocks of limestone (Sedimentary rock composed largely of mineral 

calcite, CaCO3, formed by either organic or inorganic processes) and gypsum (Hydrous 

calcium sulfate, CaSO4 · 2H2O, a soft and common mineral in sedimentary rocks). This 

formation covers the northern section of the study area which is considered a high 

plateaus geomorphic unit. 

 

Figure 9: Limestone rocks in the Yuncaypata Formation in the northern section of the 
study area watershed Cusco, Peru 
 

Hydrogeologically this group is considered an aquifuge (a rock that contains no 

interconnected openings or interstices and therefore neither absorbs nor transmits water). 
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In many cases the limestone blocks are small aquifers that are very temporal because of 

their magnitude.  

 

The Puquin Formation (Eocene) 

This formation (Figure 10) is predominantly red in color and comprised of an 

intercalation of fine sandstone, mudstone, and shale. There are also some thin layers of 

limestone and gypsum.  

 
Figure 10 The highly eroded Puquin Formation in the western part of the study area 
watershed Cusco, Peru 
 

This formation covers the western part of the study area; it is contiguous with the Kayra 

Formation (sandstone). It is conforming and anticline with South– North direction in the 

southern part of the study area. Like the Yuncaypata and Puquin Formations, is 

considered an aquifuge.  
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The Kayra Formation (Upper Oligocene) 

This formation (Figure 11) is made up of sandstone layers, where the grains have 

different diameters from fine to coarse grains, and lenses of shale. The grains are mainly 

composed of quartz and feldspars. The whole formation is about 3000 meters thick. 

 
Figure 11 Southwest side of the Kayra Formation in Cusco, Peru 

 

The Kayra Formation has three exposures in the study area. One is located on the North 

side of the study area, which connects with the Yuncaypata Formation at a fault.  The 

second and third exposures are in the South-East and South-West sections of the study 

area respectively. Both are in direct contact with the Puquin Formation. 

 

This is the most important formation from a hydrogeological perspective. It is very 

fractured due to tectonic events during the formation of the Andes. This formation is 

considered the most important aquifer (a permeable material through which groundwater 
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moves) in the entire watershed. It has an average permeability of K= 35.5 m/day. The 

Kayra formation covers most of the watershed.  

 

Intrusive Rock 

This is an altered Micro-Diorite rock, greenish in color because of the high concentration 

of epidote mineral. Its exposure is in small blocks located in the Northern side of the 

study area. It is not important hydrogeologically because the exposure is very small and 

isolated.  

 

The Pumamarca Formation (Quaternary) 

This formation is a deposit of eroded materials coming from Yuncaypata Formation. It is 

composed of small pieces of limestone, and greenish, reddish, and yellowish silts. Its 

principal exposure is the Northern part of the study area.  This is considered an Aquitard 

(a layer of rock having low permeability that stores groundwater but delays its flow) and 

it is not important in terms of hydrogeology because of the very small area that it covers. 

 

The San Sebastian Formation (Quaternary) 

The San Sebastian Formation (Figure 11) is made up of horizontal layers of gravel, sand 

and clay. It is about 50 m. thick. The base is predominantly sand and clay. The gravel at 

the top came from the alluvial cones deposits. The sand and clay deposits on top came 

from fluvial and lake deposits. Because of the flat surface of these deposits, it is used for 

agriculture. In fact, most of the urbanized area, of the city of Cusco, is over this deposit. 
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Its principal exposure is located on the East side of the study area, and makes up the 

foundation of the city of Cusco.  

 

 
Figure 12 Layers of the San Sebastian Formation in Cusco, Peru 
 
This formation is considered an aquifer. Its high porosity allows the runoff water to pass 

through its structure to lower aquifers. The average permeability is about K=24 m/day.   

 

Fluvio-glacial deposits 

The fluvio-glacial deposits are mainly composed by sandstone blocks within gravel and 

silt matrix. These deposits are mainly located in the Saphy Valley, in the northern part of 

the study area.  These deposits have similar hydrogeology characteristics like coluvial 

deposits but with very high mass volume.  

 

Alluvial deposits  

The alluvial deposits are composed of clastic rocks where the principal components are 

sandstone within clay and sand matrix. These deposits are the result of the deposits of 
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eroded materials coming from the upper level in the valleys. Its thickness depends on the 

magnitude of the deposits and the size of the valley from which it comes. The principal 

exposure is in the northern part of the study area. It is the foundation of urban areas. The 

alluvial deposits have different hydrogeology characteristics depending on the nature of 

the materials of its composition.  

 

3.4.2 Principal Aquifers 

The Cusco watershed, like many other watersheds in the Andes, has suffered many 

tectonic events. Tectonics is concerned with the orogenies and tectonic development of 

cratons and tectonic terrenes as well as the earthquake and volcanic belts which directly 

affect much of the global population. Tectonics generated the Andes in South America. 

Tectonic events folded, fractured, and faulted the sedimentary rocks. The result of which 

was most of these fractured rocks becoming aquifers. 

 

Cusco is surrounded by large aquifers. The Kayra Formation is the principal component 

of these aquifers because of its primary porosity made up of porous or inter-granular 

space, and secondary porosity comprised of fractures.  

 

3.4.3 Principal Recharge Areas  

The principal recharge areas are located on the same areas where the aquifers are exposed 

– those areas are covered by soils, in some cases bare soil. The infiltration rate depends 

on the fracture density and the fracture characteristic (open or filled by dust and/or clay).  
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3.4.4 Structural Geology  

The tectonics has a strong relationship with stratigraphy. Tectonics studies the crustal 

deformation processes. Folding and faulting on the Earth's surface has been deformed. 

This deformation is the result of forces that are strong enough to move ocean sediments 

to an elevation many thousands meters above sea level. That is how the Andes were 

formed. In fact, the tectonic events had been fractures the rocks, most of them are 

potential aquifers like the Kayra Formation. 

 

A fold is a bend in rock caused by compressional forces. Folds are most visible in rocks 

that contain layering. There are different kinds of bending: Monocline, Anticline, and 

Syncline. There is an important Anticline in the study area in the Puquin Formation. 

 

Faults are formed in rocks when the stresses overcome the internal strength of the rock 

resulting in a fracture and posterior displacement. A fault can be defined as the 

displacement of once connected blocks of rock along a fault plane. This can occur in any 

direction with the blocks moving away from each other. Faults occur from both tensional 

and compressional forces. The principal faults located in the study area are: the 

Tambomachay, Saphy, and Huancaro faults. The first two of which are in the northern 

section of the study area and the Huancaro fault is in the southern part of the study area. 
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3.4.5 Geomorphology 

The study area is located in the western part of Cusco watershed. The principal 

geomorphology units are:  

• The Ccoro Ccoro Mountains are located in the northern section of the study 

area and extend in an East-West direction. Their altitude ranges from 3900 to 

4400 m above the sea level. They are predominately composed of the Kayra 

Formation. The southern border of these mountains is delineated by the 

Tambomachay fault where the high plateaus begin. This area is used only by 

animals for grazing. 

 

• Sacsayhuaman – Sencca High plateau is located towards the north of the 

study area and extends in an East–West direction. It has an average altitude of 

3800 m above sea level. The Yuncaypata Formation is the principal geological 

unit in this area. It is delineated by the Ccoro Ccoro Mountains in the north 

and the Cusco depression in the south. Most of this area is used for 

agriculture, farming, and mining for construction materials. 

 

• Pichu- Ccorca Mountains are located in the western part of the study area 

and extend in a North – South direction.  Their altitude ranges from 3500 to 

4000 m above sea level. Their geology is mainly composed of the Kayra and 

Puquin Formations. The eastern border of these mountains is delineated by the 

Cusco Depression. This area is used for agriculture and grazing.  
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• Saphy Valley is in the northern part of the study area and extends from north 

to south.  Its altitude ranges from 3450 to 3900 m above sea level. Its geology 

is mainly composed of glacial deposits. Its stream flows from north to south 

and makes up one of the principal tributaries of the Cusco Watershed. This 

valley is mainly forested with eucalyptus trees. Because of its “V’ shape and 

very deep morphology, this valley is considered as a very young valley.  

Because of its proximity to downtown Cusco and the Saqsayhuman 

archeological side, the lower part of the valley is used as a recreational area. 

Higher altitudes of the valley are used for agriculture, predominately potato. 

The highest areas – above 4200 m are grassland (typically, the Ichu grass) 

used as grazing for llamas.  

 

• Puquin Valley is located on the Center - Western part of the study area and 

extends from West to East. Its altitude ranges from 3450 to 3800 m above sea 

level. Its geology is mainly composed of the Puquin Formation. Its stream 

flows from West to East and becomes part of one of the principal tributaries of 

the Cusco Watershed. This valley is considered to be very young. Part of this 

valley has intensive geodynamic activity because of the geology and the 

steepness.   The lower part of this valley has been inhabited due to 

uncontrolled, informal, urban sprawl. It is considered hazardous due to 
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intensive erosion in middle level of the valley. The higher area is mainly 

agriculture and grasslands.  

 

• Huancaro Valley is located on the South side of the study area and extends 

from South to North. Its altitude ranges from 3400 to 4300 m above sea level. 

Its geology is mainly composed of the Kayra and Puquin Formations. Its 

stream flows from South to North and flows into one of the principal 

tributaries of the Cusco watershed. It is also considered a young valley. This is 

the largest subwatershed of the study area. The very lowest part of this valley 

is covered by urban areas and the rest is agricultural land grass and forest 

land, this subwatershed has the highest percentage of bare soil areas.  

 

• Chocco Valley is an important tributary for the Huancaro Valley. It is located 

in the southern section of the study area and extends from South to North. Its 

altitude ranges from 3400 to 4100 m above sea level. Its geology is mainly 

composed of the Kayra Formation. Its stream flows from South to North. It is 

also considered a young valley.  The lowest part of this subwatershed has very 

small urban areas and some agricultural lands. The middle section is very 

steep and covered by eucalyptus trees. The upper areas are agriculture and 

grasslands. 
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• The Cusco Depression is the lowest part of the study area watershed. It is 

part of the regional high plateau, close to the Cordillera Oriental in the 

Peruvian Andes. Locally it is called the Cusco Valley. Its southern border is 

the Vilcaconga mountain range and its northern and western borders are the 

Cusco mountains. The Cusco watershed base extends from NW – SE direction 

with 35 km length and 1.5 to 3.5 wide. The principal sediment materials are 

gravel, sand, slime and clay. Its flat surface makes it suitable for urbanization 

– The city of Cusco was founded on this area.  

 

3.4.6 Drainage  

In geomorphology, a drainage system is the pattern formed by the streams, rivers, and 

lakes in a particular watershed. They are governed by the topography of the land, whether 

a particular region is dominated by hard or soft rocks, and the gradient of the land.  

 
Dendritic drainage systems are the most common form of drainage system in the Cusco 

watershed and in the Andes. The term dendritic comes from the Greek word "dendron", 

meaning tree, this is because the spatial distribution of the streams and their tributaries 

looks like a tree where the main stream conforms the trunk and the tributaries the 

branches. The study area has three main streams (Saphy, Puquin, and Huancaro). A map 

of the study area watershed’s drainage system can be seen in Figure 13. 
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Figure 13 Map of study area watershed’s drainage system generated with ArcGIS 9.x 
 
 
3.5 Soils  

Soils are a naturally occurring, unconsolidated material on the surface of the earth, 

capable of supporting life. Soil formation is the combined effect of physical, chemical, 

biological, and anthropogenic processes. Soil has three components: solid, liquid, and 

gas. Soil is a very important factor for water retention and infiltration into the aquifers 

and plays an important role in the aquifer recharge (naturally or artificially). Soil and 

aquifer exposure in study area can be seen in Figure 14. 
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Figure 14 Soil and aquifer exposure of a section of the study area watershed in Cusco, 
Peru 

 
 

3.5.1 Soil Erosion 

Soil erosion is the naturally occurring process of the displacement of solids. The agents 

of soil erosion are water and wind. Soil erosion may be a slow process that continues 

relatively unnoticed (like Kayra Formation), or it may occur at an alarming rate causing 

serious loss of topsoil (like Puquin Formation). The loss of soil from farmland may be 

reflected in reduced crop production potential, lower surface water quality and damaged 

drainage networks especially when they get to the urban areas. 
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CHAPTER IV LAND COVER/USE CLASSIFICATION USING REMO TE 
SENSING AND DIGITAL IMAGE PROCESSES. 

 
 
 

Land use is defined as the human modification of natural environment or wilderness into 

man-made surroundings. Urban and agricultural land uses are two of the most common 

high-level classes of use. Land cover refers to the physical and biophysical materials 

found on the surface of the earth. Land covers include grass, water, pavement, trees, bare 

ground, and houses.  There is a strong relationship between land use and land cover. 

However land use is described as how people utilize the land in socio-economic 

activities, urban or agricultural. These activities cause an important effect in land cover 

especially with those considered as natural resource.  

 

Land cover information is part of the requirements for running the AGWA 2.0 – SWAT 

modeling tool. In addition, this information forms part of a new geodatabase for the 

Cusco watershed that will be used for future studies like land cover change, land use 

decision making and monitoring, urban planning, development of environmental 

indicators, climate change monitoring, and identifying areas for best watershed 

management practicing and conservation of the natural resources. 

  

There are two principal methods for land use/cover classification: field survey and by the 

analysis of remotely sensed imagery. The method used in this research was based on the 

analysis of remote sensing imagery by using the Erdas Imagine software and a high 
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resolution QuickBird image. Sometimes there are confusions on land cover and land use 

classifications, especially if it has to deal with natural resources, for example there are 

definitions for grass as a land cover (natural resource) and as a land use (grazing). In the 

remote sensing environment both classifications have the same properties so they are 

considered as one feature class.  

 

4.1 Remote Sensing and Digital Image Process 

Remote sensing is a rather simple, familiar activity that we all do in our daily life but that 

gets complicated when we increase the scale. As we view the screen of our computer 

monitor, we are actively engaged in remote sensing. A physical quantity (light) emanates 

from that screen, which is a source of radiation. The radiated light passes over a distance, 

and thus is "remote" to some extent, until it encounters and is captured by a sensor (our 

eyes). Each eye sends a signal to a processor (the brain), which records the data and 

interprets this into information. Several of the human senses gather their awareness of the 

external world almost entirely by perceiving a variety of signals, either emitted or 

reflected, actively or passively, from objects that transmit this information in waves or 

pulses (Jensen, 2005).  Remote sensing, in terms of application, is the small or large scale 

acquisition of information of an object or phenomenon from the ultraviolet, visible, 

infrared, and microwave regions of the electromagnetic spectrum by means of 

instruments such as cameras, scanners, lasers, linear arrays, and/or area arrays located in 

platforms such as aircraft or spacecraft and the analysis of acquired information by means 

of visual and digital image processing (Jensen, 2005). 
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Remote sensing makes it possible to collect data on dangerous or inaccessible areas. 

Remote sensing applications include monitoring deforestation in areas such as the 

Amazon Basin, the effects of climate change on glaciers and Arctic and Antarctic 

regions, and depth sounding of coastal and ocean depths (Jensen, 2005).  Remote sensing 

was used to determine the features classes present in this study.  The exact process used 

to determine land cover classification for the study area is detailed in Appendix 1.  

 

4.2. Land Cover Classifications for Study Area Watershed 

The resulting land cover classification from the remote sensing and spatial analysis has 7 

distinct classes which are described below: Trees (forest land), Grassland (including 

shrubs), Bare soil, Agricultural land, Asphalt, Concrete (including urban), and Clouds 

(including metal roofs). Error analyses of the accuracy of these classifications detailed in 

Appendix A found strong agreement or accuracy between the classification map and the 

ground reference information given by the main image, ground control points and 

hardcopy maps. 

 

4.2.1 Trees (Forest Land) Class 

The tree land cover class (Figure 15) considers all those areas with high density of trees, 

especially eucalyptus. Those are located in areas with high slope and very deep soils.  

Saphy Valley has the large areas of forest in the study area. There are small areas or 

patches in the rest of the study area, most of them are less dense or are mixed with 

shrubs. The understory can include shrubs, grass or bare soil.   
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Figure 15 Example of tree land cover class in Cusco, Peru 
 

The eucalyptus tree is not native to the Andes. Before the Spanish arrived there were lot 

of varieties of trees and brushes. During colonization, the valley inhabitants started to 

eliminate the native plants and trees to use them as firewood. The eucalyptus, imported 

from Australia for the paper industry, started to dominate most of the valley beginning in 

1880.These trees are now used in construction of houses (roofs and floor structure), and 

as firewood. The eucalyptus is now having a negative impact in the environment because 

it decreases the soil’s fertility, uses a lot of ground water, and acidifies the soil preventing 

the growth of other plants, including native species, around them. On the other hand, 

eucalyptus trees have been used in land slide control like in “El Bosque” neighborhood 

(1999), in the west side of Cusco city, where the eucalyptus is consuming some of the 

soil’s water and also their roots are stabilizing the landslide movement. In the remote 

sensing classification this feature is represented by a dark green color. 
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4.2.2 Grasslands Class 

Grasslands (Figure 16) are present in small and big patches all over the study area 

including in urban areas. Most of the small patches of grassland are less than 2 hectares 

and are used as sport fields and the big patches are used as grazing lands.  

 

 
Figure 16 Example of grassland class of land cover in Cusco, Peru 
 

The most predominant grass in the Cusco valley is Pennisetum clandestinum known as 

kikuyu grass imported from Kenya. It was firstly planted in the Cusco valley in 1928 as 

an ornamental grass and as pasture for cattle. Several years later it spread out all over the 

region with both positive and negative consequences for farmers. It provides a great food 

for livestock and helps to prevent soil erosion and increase the infiltration rate. However, 

because it spreads so easily, it can take over farmlands very quickly. This class also 

includes some areas with shrubs. In the remote sensing classification, this feature is 

represented by a light green color. 
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4.2.3 Bare soil Class 

Bare soil class (Figure 17) corresponds to areas without cover or with very poor cover. 

Most of these areas correspond to rock outcrop or areas with heavy erosion. Some of 

these areas are used for rotary farming or cycled farming in which farmland is not used 

for certain periods for rest, for example every 5 or 6 years. This method is used due to a 

lack of water sources and organic materials as part of the soil components.  This bare soil 

classification does not acknowledge any differences between bare soils and rock outcrop 

because both have the same reflectance even though they have different composition, 

structure, and hydraulic response which most likely has minor implications for the 

accuracy of the modeling. The remote sensing classification of this class is represented by 

a tan color. 

 

 

Figure 17 Example of bare soil land cover class in Cusco, Peru 
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4.2.4 Agricultural (Farmland) Class 

Agricultural class (Figure 18) corresponds to areas where farming is practiced. These 

areas are located outside the town or urban areas. The principal characteristic for these 

areas is the constant farming, every year, and sometimes with more than one harvest per 

year. In general, these terrains have a very rough surface and when they are cultivated 

they have furrows. In the remote sensing classification this class is represented by the 

color brown. 

 
Figure 18 Example of agriculture land cover class in Cusco, Peru  
 

4.2.5 Asphalt Class 

Asphalt is the main component of principal roads in the study area; the pavement is a 

mixture of asphalt (a product of petroleum), sand, crushed rocks or gravel. It is present in 

urban and surrounding areas.  In the remote sensing classification this class is represented 

by the color pink. 
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4.2.6 Urban Class 

Urban class (Figure 19) corresponds to all areas with houses and infrastructures like 

commercial centers and concrete parks, such as basketball courts. This class is 

predominantly found midway in the study area on the eastern side, where the city of 

Cusco is located. This class includes tile roofs, sport parks, concrete patios of some 

houses, and concrete roads and streets. Houses and concrete structures are classified as 

one land cover class. In the remote sensing classification this class is represented by the 

color orange. 

 

 
Figure 19 Example of urban areas land cover class in Cusco, Peru 
 

4.2.7 Clouds 

Clouds class was included in this classification because clouds cover large areas of the 

image of the study area – especially in the northern section. These clouds also have 

shadows that influence the ability to classify land cover using the Erdas software. The 
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shadows’ reflections look similar to trees so in some parts they have been classified as 

tree class. In addition, the urban areas have some buildings with steel sheet roofs which 

look the same as the clouds’ shadows, but these are few and cause little problems in the 

overall classification. In the remote sensing classification this class is represented by the 

color white. 
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CHAPTER V WATERSHED MODELING WITH AGWA 2.0 – SWAT 
 
 

A watershed is considered a land where water, from rain or snow melt, drains down the 

hill into a water body like river, lake or ocean. The drainage system collects all the water 

that runs on the watershed and channels it into a waterway which goes into a bigger 

watershed, basin or into a major body of water. Watershed modeling is a complex process 

which involves many factors including hydrology, land cover/use, topography, drainage 

system, geology, and more. 

 

5.1 AGWA 2.0 – SWAT Description and Uses 

Automated Geospatial Watershed Assessment 2.0 (AGWA 2.0) is designed to evaluate 

relative change and can only provide qualitative estimates of runoff and erosion (Miller et 

al., 2007).  It cannot provide reliable quantitative estimates of runoff and erosion without 

careful calibration. It is also subject to the assumptions and limitations of its component 

models, and should always be applied with these in mind. AGWA 2.0 can be found from 

the website: http://www.tucson.ars.ag.gov/agwa/. 

 
Using digital data in combination with the automated functionality of AGWA greatly 

reduces the time required to use one of the two watershed modeling tools available 

through AGWA (SWAT and KINEROS). Through a robust and intuitive interface the 

user selects an outlet from which AGWA delineates and discretizes the watershed using 

the DEM. The watershed elements are then intersected with soil, land cover, and 

precipitation (uniform or distributed) data layers to derive the requisite model input 
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parameters. The model is then run, and the results are imported back into AGWA for 

visual display. For more information on AGWA go the the AGWA website at: 

http://www.tucson.ars.ag.gov/agwa/) 

 

SWAT is the acronym for Soil and Water Assessment Tool, a river basin, or 

watershed, scale model developed by the USDA Agricultural Research Service (see 

http://www.brc.tamus.edu/swat/). SWAT was developed to predict the impact of land 

management practices on water, sediment and agricultural chemical yields in large 

complex watersheds with varying soils, land use and management conditions over long 

periods of time. To satisfy this objective, the model: 

•  is physically based. Rather than incorporating regression equations to 

describe the relationship between input and output variables, SWAT requires 

specific information about weather, soil properties, topography, vegetation, 

and land management practices occurring in the watershed. The physical 

processes associated with water movement, sediment movement, crop growth, 

nutrient cycling, etc. are directly modeled by SWAT using this input data.  

Benefits of this approach are:  

�  watersheds with no monitoring data (e.g. stream gage data) can be 

modeled; 

� the relative impact of alternative input data (e.g.changes in 

management practices, climate, vegetation, etc.) on water quality 

or other variables of interest can be quantified; 
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• uses readily available inputs. While SWAT can be used to study more 

specialized processes such as bacteria transport, the minimum data required to 

make a run are commonly available from government agencies;   

• is computationally efficient. Simulation of very large basins or a variety of 

management strategies can be performed without excessive investment of 

time or money; and 

• enables users to study long-term impacts. Many of the problems currently 

addressed by users involve the gradual buildup of pollutants and the impact on 

downstream water bodies. To study these types of problems, results are 

needed from runs with output spanning several decades. 

 

SWAT is a continuous model able to simulation many decades at a daily time step to 

support a long-term water yield analysis. The model is not designed to simulate detailed, 

single-event flood routing.   For more information on SWAT go to the SWAT website at: 

http://www.brc.tamus.edu/swat/. 

 
The output variables given by using AGWA 2.0 – SWAT are: 

 
• Channel discharge (m3/day) 

• Percolation (mm) 

• Surface runoff (mm) 

• Transmission lost (mm) 

• Water Yield (mm) 
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• Sediment Yield (T/ha) 

• Evapotranspiration (mm) 

 
It is important to mention that most of the required data files were saved in the same 

format as shown in the tutorial. In some cases the tutorial content was simply replaced 

with new data for this study especially for .tmp and .wgn files. And, some files were 

replaced with new files containing the information from the study area. For example the 

precipitation file is located on AGWA> datafiles> precip.  

 

5.2 AGWA 2.0 – SWAT Data Requirement  

Automated Geospatial Watershed Assessment 2.0 (AGWA 2.0) requires different kinds 

of files, raster and shape files, most of which are generated prior to the modeling process, 

although some are generated during the process. The grid or raster basic files are the 

digital elevation model, flow direction grid, and flow accumulation grid.  Shape files 

include principal outlets points, and weather stations.  

 

5.2.1 Digital Elevation Model (DEM)  

A Digital Elevation Model (DEM) (Figure 20) is a digital representation of the 

topography. This file is used by AGWA for determining watershed boundaries. It was 

created by using the Arc Info tools (ArcToolbox > 3D Analysis tool > Raster 

interpolation > Topo to Raster) and contour lines and drainage shape files, mentioned in 

chapter 3.2.3. The cell size is 10 x 10 m. 
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Figure 20 Digital elevation map of study area watershed generated by AGWA 2.0 – 
SWAT 
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5.2.2 Flow Direction Grid 

A flow direction grid (Figure 21) is a digital representation of water flow direction by 

cell. In this process every cell has a neighborhood with its own value. The main cell is 

used to calculate the maximum drop value which would be the direction of water flow.  

As a result, there are 8 possible directions: E, SE, S, SW, W, NW, W, and NE. The cell 

size is 10 x 10 m. 
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Figure 21 Flow direction grid of the study area watershed generated by AGWA 2.0 – 
SWAT  
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5.2.3 Flow Accumulation Grid 

The flow accumulation function calculates accumulated flow as the accumulated weight 

of all cells flowing into each downslope cell in the output raster, the result of which is the 

flow accumulation grid (Figure 22). If no weight raster is provided, a weight of one is 

applied to each cell, and the value of cells in the output raster will be the number of cells 

that flow into each cell (ArcGIS Desktop help). The flow accumulation grid shows the 

cell accumulation downhill into the drainage channels (streams) such that the border 

areas are all zero values (light blue) and the drainage channels have higher values (dark 

blue) since there is cell accumulation and flow. The cell size is 10 x 10 m.  
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Figure 22 Flow accumulation grid of study area watershed generated by AGWA 2.0 – 
SWAT  



73 

5.2.4 Land Cover/Use  

This is a digital representation of the land cover/use of the study (Figure 23). This map 

was created using Erdas Imagine 9.1 (see Chapter 5.1). The asphalt class was merged 

with urban land cover class because of its predominance in those areas and its similar 

hydraulic responses. The cell size in this digital map is 0.60 x 0.60 m. 
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Figure 23 Land cover/use classification of study area watershed generated by Erdas 
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5.2.5 Shapefiles  

Ovalo watershed outlet point is a shapefile located in the lowest part of the study area 

and corresponds to the principal watershed outlet point. All the surface runoff water from 

the entire study area watershed passes through the Ovalo outlet point. 

  

Perayoc Weather Station point is a shapefile that corresponds to the location of the 

Perayoc weather station. As noted in Chapter 3, it is not clear if the data came from this 

exact weather station, but they are almost exactly the same as the data from this station. 

Peryoc is located on the campus of the National University San Antonio Abad of Cusco.  

 

Soil Component is a polygon shapefile which represents the soil types across the study 

area. This data was downloaded from AGWA web site > GIS data > FAO soil > FAO 

soils map – South America.  Then the soil map that includes the study area was selected. 

By overlaying the study area watershed map onto the FAO soils map, the soil classes 

were identified. According to the FAO soils map there are only two different classes of 

soil present in the study area watershed: I-Hl-Kl-bc, in the southern section of the study 

area, and Kl3-3in the northern section of the study area. However, field survey found that 

while these soil classes do coincide somewhat with the soils and geology present, there 

many more than two classes of soil in the area. It appears that the FAO soils map for this 

area is not very complete. But for the purposes of this research, the only option was to 

classify the soils based on information already existing in the FAO soil map which have 

the following characteristics each: 
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• I-Hl-Kl-bc : Where: I: Lithosol , soils which are limited in depth by continuous 

coherent and hard rock within 10 cm of the surface. HI: Luvic Phaeozems: Other 

Phaeozems having an argillic B horizon. Kl: Luvic Kastanozems: Kastanozems 

having an argillic B horizon; a calcic or gypsic horizon may underlie the B 

horizon.  

• Kl3-3a: Where: Kl: Luvic Kastanozems, Kastanozems having an argillic B 

horizon; a calcic or gypsic horizon may underlie the B horizon.  

 

5.2.6 Look-up Tables  

Land cover look-up table (Table 2) is a dBASE formatted table containing parameter 

values by land cover class. Each record is identified by a unique key, identical to the 

values contained in the VALUE field of the land cover GRID. Additional parameters 

include cover, interception, Manning's N, percent impervious and curve number values 

(A, B, C, and D). AGWA2 provides several lookup tables; custom tables, containing the 

parameters described above, can also be utilized for land cover parameterization (see the 

AGWA Users’ manual located at: http://www.tucson.ars.ag.gov/agwa/. Table 2 outlines 

the results where A, B, C, and D are the Curve Number (CN) values for each hydrologic 

group, Cover is percentage of cover, INT  is interception, N is Manning’s number and 

IMPER  is percent impervious. 
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Table 2 AGWA 2.0 – SWAT land cover look-up table  
 

 
 

5.2.7 Precipitation components   

Unweighted precipitation file contains a daily precipitation record from 1965 to 2002 

for the city of Cusco. It was used for generating the precipitation file for running SWAT.  

The file was processed by using excel software then saved in .dbf format.  The file name 

is cu65_02.dbf and was saved in the AGWA2 data files.  

 

5.3 Results for Model 1    

The subwatersheds outputs table for Model 1 (Table 3) presents the output for each 

subwatershed and includes the following information for each: CN: Curve Number, 

ET_mm: estimated evapotranspiration (mm), Perc_mm: estimated percolation for the 

subwatershed (mm), SurQ_mm: estimated surface runoff for the subwatershed (mm), 

Tloss_mm: estimated transmission loss for the subwatershed (mm), WatYld_mm : 

estimated water yield (mm), and SedYld_t_h: estimated sediment yield (t/ha). 
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Table 3 Subwatersheds outputs for Model 1 of the study area watershed generated by AGWA 2.0 - SWAT 
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Stream outputs for Model 1 (Table 4) includes the following information for each 

stream: WatYld_mm : estimated water yield (mm), Q_cmd: channel runoff (m3/day), 

Tloss_m3s: estimated transmission loss (m3/s) which is the average daily rate of water 

loss from reach by transmission through the streambed during time step (m3/s), (the 

results of which for all streams in the study area watershed are zero probably due to the 

lack of ephemeral streams or ephemeral streams so insignificant that the software 

considers them to have zero values),  and SedYld_mtn: Sediment yield (metric tons/ha) 

which is the sediment that comes from the Hydrologic Response Unit (HRU) that is 

transported into the main channel during the time step. 
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Table 4 Stream outputs for Model 1 of study area watershed generated by AGWA 2.0 – 
SWAT  
 

 
 

5.3.1 Model 1 Erosion and Sediment Yield Results 

Erosion and sediment yield (ton/ha) are estimated for each HRU with the Modified 

Universal Soil Loss Equation (MUSLE) (Williams, 1975). While the USLE uses rainfall 
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as an indicator of erosive energy, MUSLE uses the amount of runoff to simulate erosion 

and sediment yield resulting in a sediment yield map (Figure 24). The substitution results 

in a number of benefits: the prediction accuracy of the model is increased, the need for a 

delivery ratio is eliminated, and single storm estimates of sediment yields can be 

calculated. The hydrology model supplies estimates of runoff volume and peak runoff 

rate which, with the subbasin area, are used to calculate the runoff erosive energy 

variable (Neitsch et al., 2001). The crop management factor is recalculated every day that 

runoff occurs. It is a function of above-ground biomass, residue on the soil surface, and 

the minimum C factor for the plant. Other factors of the erosion equation are evaluated as 

described by Wischmeier and Smith (1978). 

 



82 

 
 
Figure 24 Sediment yield map for Model 1 (actual conditions) of study area watershed 
generated by AGWA 2.0 – SWAT  
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5.3.2 Model 1 Water Yield Results 

Water yield (mm H2O) is the total amount of water leaving the HRU (hydrologic 

response unit) and entering main channel during the time step.  

 

WYLD = SURQ + LATQ + GWQ - TLOSS - pond abstraction 

 

 Where:  

SURQ: Surface runoff contribution to stream flow during time step (mm) 

LATQ : Lateral flow contribution 

GWQ: Groundwater contribution to streamflow (mm H2O). Water, from 

the shallow aquifer, that enters the main channel during the time 

step. Groundwater flow is also referred to as baseflow. 

TLOSS: Average daily rate of water loss from reach by transmission 

(Neitsch et al., 2001)  

This results in the following a water yield map of the study area watershed (Figure 25). 
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Figure 25 Water yield map for Model 1 (actual conditions) of the study area watershed 
generated by AGWA 2.0 – SWAT  
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5.3.3 Model 1 Percolation Results 

In this case, water that percolates past the root zone during the time step (mm). There is 

potentially a lag between the time the water leaves the bottom of the root zone and 

reaches the shallow aquifer. Over a long period of time, this variable should equal 

groundwater percolation. The results are displayed a water percolation map of the study 

area (Figure 26). 
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Figure 26 Water percolation map for Model 1 (actual conditions) of study area watershed 
generated by AGWA 2.0 – SWAT  
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5.3.4 Model 1 Evapotranspiration Results 

Evapotranspiration is a collective term for all processes by which water in the liquid or 

solid phase at or near the earth's surface becomes atmospheric water vapor. 

Evapotranspiration includes evaporation from rivers and lakes, bare soil, and vegetative 

surfaces; evaporation from within the leaves of plants (transpiration); and sublimation 

from ice and snow surfaces. The model computes evaporation (mm) from soils and plants 

separately as described by Ritchie (1972). Potential soil water evaporation is estimated as 

a function of potential evapotranspiration and leaf area index (area of plant leaves relative 

to the area of the HRU). Actual soil water evaporation is estimated by using exponential 

functions of soil depth and water content. Plant transpiration is simulated as a linear 

function of potential evapotranspiration and leaf area index (Neitsch et al., 2001).  The 

results for model 1 are presented in a map (Figure 27). 
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Figure 27 Evapotranspiration map for Model 1 (actual conditions) of study area 
generated by AGWA 2.0 – SWAT  
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5.3.5 Model 1 Surface Runoff Results 

Surface runoff, or overland flow, is flow that occurs along a sloping surface. Using daily 

or sub-daily rainfall amounts, SWAT simulates surface runoff volumes (mm) and peak 

runoff rates for each HRU. 

 

Surface runoff volume is computed using a modification of the SCS curve number 

method (USDA Soil Conservation Service, 1972) or the Green & Ampt infiltration 

method (Green and Ampt, 1911). In the curve number method, the curve number varies 

non-linearly with the moisture content of the soil. The curve number drops as the soil 

approaches the wilting point and increases to near 100 as the soil approaches saturation. 

The Green & Ampt method requires sub-daily precipitation data and calculates 

infiltration as a function of the wetting front matric potential and effective hydraulic 

conductivity. Water that does not infiltrate becomes surface runoff. SWAT includes a 

provision for estimating runoff from frozen soil where a soil is defined as frozen if the 

temperature in the first soil layer is less than 0°C. The model increases runoff for frozen 

soils but still allows significant infiltration when the frozen soils are dry (Neitsch et al., 

2001). The results are found in a surface runoff map (Figure 28). 
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Figure 28 Surface runoff map for Model 1 (actual conditions) of study area watershed 
generated by AGWA 2.0 – SWAT 
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Peak runoff rate predictions are made with a modification of the rational method. In brief, 

the rational method is based on the idea that if a rainfall of intensity i begins 

instantaneously and continues indefinitely, the rate of runoff will increase until the time 

of concentration, tc, when all of the subbasin is contributing to flow at the outlet. In the 

modified Rational Formula, the peak runoff rate is a function of the proportion of daily 

precipitation that falls during the subbasin tc, the daily surface runoff volume, and the 

subbasin time of concentration. The proportion of rainfall occurring during the subbasin 

tc is estimated as a function of total daily rainfall using a stochastic technique. The 

subbasin time of concentration is estimated using Manning’s Formula considering both 

overland and channel flow (Neitsch et al., 2001).  

 

5.3.6 Model 1 Channel Runoff or Streamflow Results  

Channel runoff or Streamflow, is the flow of water in streams, rivers, and other channels, 

and is a major element of the water cycle. It is one component of the runoff of water from 

the land to waterbodies, the other component being surface runoff. Water flowing in 

channels comes from surface runoff from adjacent hill slopes, from groundwater flow out 

of the ground, and from water discharged from pipes. The channel runoff (m3/day) map 

(Figure 29) for model 1 follows. 
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Figure 29 Channel runoff map for Model 1 (actual conditions) of the study area 
watershed generated by AGWA 2.0 – SWAT 



93 

CHAPTER VI PREDICTING CHANGE IN WATERSHED CHARACTER ISTICS 
USING AGWA 2.0 – SWAT 

 
 
The first model, developed in the previous chapter, describes current, actual watershed 

conditions. The most important outputs obtained from the first model are: sediment yield, 

water yield, percolation, surface runoff, and evapotranspiration. It is very important to 

know the current conditions of the watershed in order to understand the dynamic of the 

watershed and its influence on downstream areas. 

 

This chapter presents a brief analysis of watershed characteristics after changing some of 

the land cover/use conditions – the bare soil component was reclassified as contour 

trenches (furrow) in one model and as forestation areas in the other. The bare soil feature 

class was chosen because the other the land use components such as urban areas, grass 

lands, and agriculture are already consolidated and are not easily changed. 

 

6.1 Model 2: Bare Soil Becomes Contour Trenches 

Model 2 considers the change of land use where the bare soils become contour trenches.  

Contour trenches are used both on hill slopes as well as on degraded and barren waste 

lands for soil and moisture conservation and forestation purposes. The trenches break the 

slope and reduce the velocity of surface runoff. It can be used in all slopes irrespective of 

rainfall conditions (i.e., in both high and low rainfall conditions), varying soil types and 

depths.  
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Trenches can be continuous or interrupted. Interrupted trenches can be in series or 

staggered, continuous trenches are used for moisture conservation in low rainfall areas 

and require careful layout. Intermittent trenches are adopted in high rainfall areas. The 

trenches are to be constructed strictly on contours irrespective of the category. For more 

information on contour trenches see the websitre:  http://www.amarjoshi.com/man.html. 

This practice is already having excellent results in the Cusco region where the principal 

objective is to increase the infiltration rate for rock aquifers. There are areas where the 

contour trenches are not only increasing the infiltration rate but also reducing the soil 

erosion and increasing the vegetation density.  

 

In preparing AGWA to create Model 2 – where bare soil becomes contour trenches, it 

was necessary to select the land cover class for contour trenches. Unfortunately, as of yet, 

AGWA 2.0 has not developed a contour trenches land cover class. As a result, the most 

similar existing AGWA land cover class had to be chosen selected. Based on an analysis 

of the characteristics of the existing land cover classes, it appeared that the curve 

numbers of the fallow land cover class were most similar to those that contour trenches. 

However, because they are not exactly the same, the results of Model 2 – contour 

trenches can not be taken at face value, but interpreted given this difference.  

 

6.1.1 Reclassifying Land Cover/use Grid for Model 2  

To change the Land Cover/use grid, it was necessary to use the Reclassify function from 

the ArcGIS toolbox. Spatial Analyst Tools> Reclass> Reclassify. In the dialog box 
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(Figure 30) the bare soil class (10) was changed into a new class: Fallow or contour 

trenches (12). 

 

 
Figure 30 AGWA2.0 – SWAT reclassify tool box for Model 2 (bare soil to trenches) of 
study area watershed 
 

It was then necessary to create a new lookup table (Table 5) that might consider the new 

class. The procedure for creating a new lookup table is in the AGWA file, AGWA> 

AGWA2> datafiles> lc_luts, which describes the following steps:  

 
• Create a new worksheet in LC_lookup.xls 
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• Copy the field names (first row) from either the NALC or MRLC worksheet.  

AGWA depends on EXACTLY these names to find the values in the table, so any 

difference will result in failure of the land cover and soils parameterization 

• Enter values for each land-cover class in your data set 

• Save the workbook (the LC_lookup.xls file) 

• Select only the cells in the new worksheet with values in them 

• Select 'Save As', and set the file type to DBF IV (.dbf). 

• Save the file in this format into your AGWA\datafiles directory 

• Excel opens two windows after you click OK - these are confirming that you can 

only save the active sheet with the dbf format, and reminding that changes to the 

workbook will be lost if step 4 above is skipped 

• The parameter for the look up table are: 

o A, B, C, and D are the Curve Number (CN) values for each hydrologic group. 

o Cover is percentage of cover 

o INT  is interception 

o N is Manning’s number 

o IMPER  is percent impervious  
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Table 5 AGWA 2.0 – SWAT lookup attribute table for Model 2 (bare soil to trenches) of 
study area watershed 
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6.2 Model 3: Bare Soil Becomes Forestation  

Model 3 considers the change of land use where bare soil become forest or vegetation. 

Vegetation plays an important role in the interactions between groundwater and surface-

water which is why forestation is one of the most important methods for water and soil 

conservation on watersheds. Forestation is the process of establishing a forest on land that 

is not a forest, or has not been a forest for a long time by planting trees or their seeds. In 

addition, vegetation has a significant impact on infiltration both by providing canopy and 

litter cover to protect the soil surface from raindrop impacts and by producing organic 

matter which connects soil particles and increases its porosity. Higher porosity increases 

infiltration and percolation rates and the water-holding capacity of the soil.   

 

Infiltration and percolation, as part of the water cycle, are important elements in the 

watershed environment.  Infiltration is the process by which water moves through the soil 

surface into the soil matrix and percolation is the process by which it moves down 

through the profile and into the underlying weathered rock. So, that is why the third 

model is analyzing the changing of bare soil areas for forest or vegetated areas.  

 
 

6.2.1 Reclassifying Land Cover/use Grid for Model 3 

For the third model, in which bare soil becomes forest, a new reclassification was 

performed using the same procedure as for model 2. Spatial Analyst Tools> Reclass> 

Reclassify. This time in the dialog box (Figure 31) the bare soil class (10) was changed 

into a new class: Trees or Forest (1). 
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Figure 31 AGWA 2.0 – SWAT reclassify tool box for Model 3 (bare soil to forest) of 
study area watershed 
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6.3 Comparison of Models 1, 2, and 3   

The results analysis started by opening the attribute table from each resulting feature 

class (streams_c1d1 and subwatersheds_c1d1) from each model. Then the tables were 

exported into Excel worksheets where all the calculations were done. 

 

The following figures and tables present the results from the most important changes for 

the 32 subwatersheds. Model 1 is the current condition of the subwatersheds, Model 2 

changes bare soil land use class into contour trenches and Model 3 changes bare soil class 

into forest class. When reviewing the results, it is important to remember that as contour 

trenches was not available as a land cover class, the fallow class was used in Model 2 

which may produce poorer results than actual contour trenches.  

 

6.3.1 Comparison of Sediment Yield Results for Models 1, 2, and 3 

The sediment yield results (Figure 32 and Table 6) are significantly different in the three 

models. Both Models 2 and 3 show decreased amount of sediment, but Model 3 results in 

a bigger decrease. A very important factor that has to be analyzed in this process is the 

subwatersheds areas, especially in those with very small areas. For example, in Model 3, 

subwatershed 21 results in a 100% decrease in sediment yield.  
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Figure 32 Graphic comparison of the 32 subwatersheds’ sediment yield changes, in tons per hectare (Tn/ha), from Models 1, 
2, and 3 of study area watershed 
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Table 6 Comparison table of the 32 subwatersheds’ sediment yield changes, in tons per 
hectare (Tn/ha), from Models 1, 2, and 3 of study area watershed 
 

 

 

These data show that Model 2 results in minor changes; the average change is about 

3.83%. The changes in Model 3, on the other hand are very significant as the average 

change is about 17.95%. Forestation would reduce the sediment yield and erosion by 

almost 18%.  
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6.3.2 Comparison of Water Yield Results for Models 1, 2, and 3 

The changes in water yield (Figure 33 and Table 7) as measured in mm, are less significant than in sediment yield. In fact, 

while the majority of subwatersheds see a decrease in water yield, some watersheds with very small surface area have 

increases in water yield as minor changes in their land use can cause a big impact. 

 

Figure 33 Graphic comparison of the 32 subwatersheds’ water yield changes, in millimeters (mm), from Models 1, 2, and 3 of 
the study area watershed  
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Table 7 Comparison table of the 32 subwatersheds’ water yield changes in millimeters 
(mm) from Models 1, 2, and 3 of study area watershed 

 

 
 
This table shows that Model 2 does not result in major changes; the average change is 

0.86%. On the other hand, the changes in Model 3 are almost four times those of Model 

2; the average change is about 3.2 %. Forestation would reduce the water yield by about 

3.2 %.  
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6.3.3 Comparison of Percolation Results for Models 1, 2, and 3 
 

The biggest changes from the models are seen in percolation (Figure 34 and Table 8) – especially in Model 3. 

 
 
Figure 34 Graphic comparison of the 32 subwatersheds’ percolation changes in millimeters (mm) from Models 1, 2, and 3 of 
study area watershed 
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Table 8 Comparison table of the 32 subwatersheds’ percolation changes in millimeters 
(mm) from Models 1, 2, and 3 of study area watershed 
 
 

 
 
This table shows that Model 2 has an average increase of 6.19%; and Model 3’ increase 

is more than five times that – 31.23 %. This means that forestation would increase the 

percolation amount and as a result the recharge of the aquifers in the areas where the 

forestation occurs.  
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6.3.4 Comparison Stream Flow Results for Models 1, 2, and 3 

The stream flow results (Figure 35 and Table 9) look a lot like those of water yield where the changes from Model 2 are not 

very different than the changes from Model 3 but in both cases there is a reduction in the amount of water flow in the streams.  

The biggest difference is that no subwatershed experiences a negative impact as seen in the water yield results. The data show 

that every subwatershed experiences a reduction in the amount of stream flow. 

 
Figure 35 Graphic comparison of the 32 subwatersheds’ stream flow changes in m3/day from Models 1, 2, and 3 of study area 
watershed 
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Table 9 Comparison table of the 32 subwatersheds’ stream flow changes in m3/day from 
Models 1, 2, and 3 of study area watershed 
 

 

This table shows that Model 2 has a considerable impact on the stream flow amount; the 

average change is about 2.51%. However, the impact of Model 3 is almost four times 

greater; here the average change is 10.27 %. Forestation would reduce the stream flow by 

about 10.27%. 
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CONCLUSIONS 
 

This study developed new data for the study area watershed, a section of the Cusco 

watershed. Climate data was obtained from information available in the public domain on 

the Internet. New, highly accurate land cover data was developed using remote sensing 

and GIS technology (ArcGIS 9.x, Erdas Imagine 9.1, Google Earth and Zonuum 

Solution) with a satellite image and field survey. Land cover was classified using Erdas 

Imagine 9.1. Points with x,y,z coordinates were generated using Zonum Solutions to 

create a topographical map. Google Earth was used to analyze the ground control points. 

Digital maps including the Digital Elevation Model (DEM), flow direction grids, flow 

accumulation grids, were generated using ArcGIS 9.x. 

 

These new data were then used in ArcGIS9.x and AGWA 2.0 – SWAT to develop a 

model that assessed the current conditions of the study area watershed.  They were also 

used to generate two additional models based on scenarios of changes in land cover.  

Model 2 was developed by changing bare soil to contour trenches (using the fallow class 

as a proxy). Model 3 was developed by changing bare soil to trees or forest. The impacts 

of the new models on water and sediment yield and water infiltration rates were then 

compared with the actual state of the study area watershed (Model 1) to determine which 

changes would have the best results. 
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Based on the analysis of the three models, in order to decrease flooding and increase 

water filtration, it is recommended that trees or forest be planted in the bare soil of the 

Cusco watershed. It is important to remember, however, that as contour trenches was not 

available as a land cover class in AGWA 2.0, the fallow class was used in Model 2 which 

most likely produced poorer results than actual contour trenches. As such, it could be 

beneficial to implement both strategies, contour trenches and trees, in the Cusco 

watershed and develop field data on the results. 

 

It is also important to note that the study area watershed contains less than 10% of the 

entire Cusco watershed. And, the study area has a lower percentage of bare soil than the 

remaining 90% of the watershed. As such, in the event the recommendations from this 

study are implemented, their impact on flooding and water infiltration would probably be 

much greater than in the study area watershed. 

 

An important follow-up activity will be to present this research to Cusco’s authorities and 

decision-makers, for them to both develop a land use and watershed management plan 

that implements the results and start to use more GIS technology in the management of 

natural resources in general. 

 

Another set of recommendations is directed to the development of the GIS technology. 

There were two main technological limitations that impeded the modeling and results that 

should be improved. First, it would be very helpful to develop more precise FAO soils 
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information for the Cusco watershed. Second, a contour trenches land cover class in 

AGWA 2.0 would enable watershed modeling to determine the impact of such trenches 

which would be very beneficial to many regions of the world. 

 

In summary, this study presents a very detailed process for watershed modeling using a 

satellite image and GIS technology including Erdas Imagine 9.1, ESRI ArcGIS 9.x, 

Google Earth AGWA 2.0 – SWAT, and Zonum Solution. The advantages of the 

application of this process and software are: time and money saved in field work data 

collection, relatively accurate results, and the ability to obtain different models by 

changing some watershed characteristics. It is hoped that this study will be used to 

improve conditions in Cusco, Peru, as a guide for others seeking to model watershed 

conditions using publicly available information, and inform the continued development 

of GIS technology. 
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APPENDIX A: DETAILED REMOTE SENSING AND DIGITAL IMA GE DATA 
PREPARATION PROCEDURE 

 

A.1 In situ Data Collection 

Data can be collected in a variety of ways and scales one of which is in situ data 

collection consisting of a series of field trips in the study area. The methodology used 

during this study was based on the location of specific land covers (equal or more than 

0.5 hectare) like grass land, bare soil, rock bed or exposure, shrubs, forest, asphalt, 

cement, roof tiles, etc. The next step was to localize the center of the feature by using a 

GPS (Garmin etrex receiver). The accuracy was within 8 m most of the time. There were 

more than 40 points collected using this method which are called the “Ground Control 

Points”  

 

A.2 Ground Control Points 

Ground Control Points (GCP) are points on the surface of the earth which have known 

coordinates. UTM or Geographic coordinate is used for those locations. For use in image 

processing, the points should be recognizable on remotely sensed images, maps and aerial 

photographs and which can be accurately located on the images. 

 

A.3 Remote Sensing Data Collection  

The process of data collection is the process of image interpretation, either visually or 

using special software like Erdas Imagine, to extract information about certain kinds of 

features or targets. Once remote sensing data have been collected, the final process is to 
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save the information obtained about feature classes for future use, either directly or using 

other software, in modeling, solving any particular problem of interest or helping on 

making decisions. 

 

A.3.1 View Meta Data in Erdas Imagine 9.1 

Using Erdas Imagine it is possible to see the image metadata information by clicking on 

the ImageInfo icon in the Viewer icon bar. The ImageInfo box (Figure 36) includes the 

following information:  

• File Info – the number of layers (3), last modified date, and file size for the 

image;  

• Layer Info  – general information from the layers like width, high, and type;  

• Statistics Info – statistic information from each layer;  

• Map Info  – the coordinate limits for the image; and  

• Projection Info – projection characteristics for the image which is UTM – 

Zone 19, Spheroid and Datum WGS 84.  
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Figure 36: Erdas Imagine 9.1 ImageInfo box containing the image metadata information 
 
 

A.4 Unsupervised Classification in Erdas Imagine 9.1 

Unsupervised classification techniques do not require the user to specify any information 

about the features contained in the images. The classification of a multispectral image is 

the process of assigning pixels into categories of like spectral signature. (Marsh, 2007)  

 

The unsupervised classification for the image was done using the following process in 

Erdas Imagine 9.1:  
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• Click on <Classifier> in the main Imagine icon bar. Click on <Unsupervised 

classification>. The Unsupervised Classification dialog displays (Figure 37). 

Then enter: 

• <Input Raster File>. Click on the <Open File> icon and navigate to Image1.img 

(the main file for the study area image) 

• <Output Cluster Layer>. Click on the <Open File> icon and navigate to the 

directory where to store the thematic layer and enter its name (imaclf8.img, 

imaclf10.img, imaclf12.img, imaclf20.img). The name depends on the number of 

classes. 

• Enter <Number of Classes> 8, 10, 12, and 20,  

• Unselect <Output Signature Set>. 

• Increase <Maximum Iterations> to 15. This will instruct the algorithm to repeat 

15 times, or until the Convergence Threshold is reached, and ensures that 

iterations do not stop prematurely. 

• Leave the <Convergence Threshold> at 0.95. This is the percent of data that 

remains unchanged between iterations. 

• Select <Classify zeros>. Since data are reflectance values and potentially range 

from 0 to 1, it is feasible that zero data values exist. Often 0 is reserved for non-

data values; in that case we would not want to classify zeros. 

• Leave <Skip Factors> at their default value of 1. 

• Click Ok  
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Figure 37 Erdas Imagine 9.1 Unsupervised Classification dialog box 
 

A.4.1 Classes Labeling Process  

The next step was to label the classes in the generated map to identify what cover type 

each class represents. The unsupervised classification was in itself easy to run, but 

recognizing and labeling of classes was a little difficult. Ground truth observations, 

obtained from the field work, were used for identifying classes; the coordinates obtained 

on the field work matched perfectly with the image coordinates. The following details the 

labeling process: 
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• Display the classification maps (imaclf8.img, imaclf10.img, imaclf12.img, 

imaclf20.img) in a Viewer, one at a time. The Raster Options, for each image, 

shows that the image is a pseudo color image, which allows the arbitrary 

assignment of any color to any pixel (class) value. 

 

• Click on <Raster/Attributes>. The <Raster Attribute Editor> displays (Figure 38) 

so it becomes possible to make change to column order, color (for feature class 

recognition).  
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Figure 38 Erdas Imagine 9.1 Raster Attribute Editor with the tree class in red 

 

• Click on a row (class) number in the <Raster Attribute Editor> and then click on 

the color cell in that row. A dialog pops up that provides color options. Select a 

color red (for better contras with the rest cells) and recognize what kind of feature 

class it is. Then change the color for the specific class (e.g. dark green for trees, 

tan for bare soil, orange for concrete, etc).  
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• Four different classifications with 8, 10, 12, and 20 classes of land cover were 

performed, all of which were analyzed individually. The final products (Figure 

39) of each were almost identical to each other 

 
Figure 39 Comparison of unsupervised classified images (and corresponding Raster 
Attribute Editor) 8 and 20 classes respectively 
 

• In the classifications with fewer numbers of classes some classes of ground 

surface cover overlapped, despite how different they were physically. For 

example there was one single class which included bare soil, grass land and house 

roof as a single class.  

• At the same time, in the classifications with higher numbers of classes, there were 

some classes that were very similar land cover. These similar land cover classes 

were often of low frequency in the image. 
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•  As a result, it was necessary to merge and recode certain land cover classes in 

order to maximize accuracy. The classification with 20 classes was used for the 

this process, which ended up with a total of 7 land cover classes, 

• Classes were merged into a single class by using the <Recode> option from the 

Raster dialog box. Additionally, the <Recode> option was used to rename classes 

and create matching labeling schemes for different classifications. It was critical 

that the attributes of the target class match the attributes of the class being merged 

with it, otherwise there would have been a conflict during the merge. 

A.4.2 Recode process  

The recode process started with the analysis of each land cover class in the four different 

classifications (8, 10, 12, and 20 classes). Each class was compared with the ground 

control points, hard copy maps, and the Google Earth Image; then according to the results 

obtained from this analysis, each class was labeled with the name that it represents in the 

ground.  As classification with high number of classes gives more accuracy and accuracy 

for matching land cover classes, and for merging classes, the classification with 20 

classes was used as the starting point for the recode and merge process for the final 

classification of 7 classes. Initially, the matching classes were labeled with the same 

name and use the same color, to avoid problems when performing the recode process. 

Then, in a separate document the desired final class scheme was recorded. 

 

The recode process continued by clicking on the Raster> Recode option then the dialog 

box display (Figure 40), click to select the row of the class to be merged, and then enter 
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the target class row number in the New Value field, in the lower portion of the dialog. 

Click Change Selected Rows. Click Apply.  

 

 
Figure 40 Erdas Imagine 9.1 recode display box showing a sample of how the 20 classes 
were merged into 7 
 

Now all the classes with similar characteristics were merged resulting in seven classes 

(Table 10). 
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Table 10 Reclassification of land cover classes 

 

Old Class Value 
New Class 

Value Color Class Name 

1,2,3 1 Dark Green Trees (includes some shadows) 
4, 5, 6 2 Green Grasslands (includes shrubs) 

7, 8, 9, 10, 11, 12, 13 3 Tan Bare soil 
14,16 4 Brown Agricultural land 

15 5 Pink Asphalt 
17, 18, 19 6 Orange  Urban(includes concrete and tile 

roofs) 
20 7 White Clouds (includes metal roofs) 

 
After all the merges on the recode list were completed, the Recode and Raster Attribute 

Editor dialogs were closed along with the Viewer displaying the classification map and 

save settings by replying Yes to each of the prompts that appeared. Figure 41 is a sample 

section of the final map with seven classes. 

 
 

Figure 41 Sample section of final land cover/use classification map using seven classes 
generated by Erdas Imagine 9.1 
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A.5 Error Matrix 

The error matrix, confusion matrix, correlation matrix, or covariance matrix, summarizes 

the relationship between two data sets, in this case the classification map (from the 

previous step) and the Google map which includes the ground control points. During the 

acquisition, processing and classification of remotely sensed data, some significant error 

accrues; therefore, it is essential to provide some assessment of the accuracy of this 

classification map. Agreement and disagreement are summarized in the cell of the error 

matrix. Finally, information in the error matrix may be evaluated using simple descriptive 

statistics. The process is described below: 

 
• First it was necessary to generate a set of random points by which would be 

possible to sample the classification map. These points are located inside the 

study area encompassed by the hard copy maps, the ground control points and the 

Google Earth image, which are going to serve as the “ground truth”. Therefore, 

using the classification map, a “subsetted map” (Figure 42), a portion of the map, 

was created that includes all the features classes from the study area.  
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Figure 42 Subsetted map of study area watershed that includes all land cover classes and 
subset dialog box generated by Erdas Imagine 9.1 for use in error matrix 
 

• To subset the map it is necessary to open a large scene in the Viewer, then 

Utility> Inquire box was selected. The inquire box, a small white outline of a 

rectangle, appears in the center of the image. Then by clicking and dragging the 

side of the inquire box the subsetted area was selected. In the displayed Subset 

dialog box enter the input file name, image20b, and the output file name, 

subset20b. The “From Inquire Box” button was clicked followed by accept, then 

accept all other defaults and clicking the following ok buttons to finish this 

process. 

 

• The next step is to click on Classifier in the main Imagine icon bar. Then Select 

Accuracy Assessment. In the icon bar of the Accuracy Assessment dialog that 
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displays, click on the Open File icon (or select File in the menu bar and then 

open). In the displayed dialog, navigate to the file name was selected. Click OK. 

In the Edit menu of the Accuracy Assessment dialog, select Create/Add Random 

Points (Figure 43) was selected. In the Add Random Points dialog that was 

displayed, the settings were modified as follows: 

- Search Count was left at 1024 

- Enter 250 for Number of Points  

- Select Stratified Random under Distribution Parameters  

- After clicking Click OK, a table of 250 points displays in the Accuracy 

Assessment dialog (Figure 43) 

 
Figure 43 Section of the subsetted map with random points identified as well as the 
Accuracy Assessment dialog box and Add Random Points dialog box generated by Erdas 
Imagine 9.1 
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• The random points were saved through file menu of the Accuracy Assessment 

dialog, by selecting Save as Annotation. The file name is strat-200smplng.ovr. 

Then click Ok and Close the Accuracy Assessment dialog. 

• Display three empty Viewers side by side and resize so that: 

- The three Viewers are same dimensions; 

- The Zoom in tool is visible in the icon bar of each Viewer; and 

- The three Viewers fit within the width of the screen as closely as possible. 

• The random points file (strat-200smplng.ovr) was opened in the first (from left) 

Viewer. The 250 points and the classification map (imaclf20b.img) were 

displayed in the second Viewer, and the main image was displayed in the third 

Viewer. 

• In the icon bar of the first Viewer that contains the points, by clicking the Inquire 

Cursor icon was displayed the Inquire Cursor. Then the Inquire Cursor dialog was 

moved below the three Viewers (Figure 44). Then the first Viewer was linked to 

the other two by clicking on the View>Link/Unlink viewers>Geographical. A 

white outline of a rectangle appears within the two classification maps. This 

rectangle simply indicates the area of the points file, which is a subset of the 

larger scene encompassed by the classification map and the main image. 



127 

 
Figure 44 Random points, classification map, and main image generated by Erdas 
Imagine 9.1 with the Inquire dialog box generated by Erdas Imagine 9.1 below 
 

• To compare the pixel class representing in the classification map and the ground 

class represented in the main image, it was necessary to position the Inquire 

Cursor on a point (in the first View) and then Zoom in to that point to read the 

pixel characteristics like ID#, and class value; and also see the same spot in the 

main image to find the ground class value. Then those values were recorded in a 

table (Table 11) to compare the classes of each point. 
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Table 11 Sample sections from the comparison table of the classification map and main 
image class used in error matrix 

 

Point # ID # Classification 
Map Value 

Main Image 
Class Value 

1 4 6 6 
2 9 3 3 
3 14 6 6 
4 19 2 2 
5 24 2 2 
. . . . 
. . . . 
. . . . 

246 1229 4 4 
247 1234 4 4 
248 1239 6 4 
249 1244 4 3 
250 1249 7 7 

 
Where: 

Class Name     Class Value 
 

Trees (includes cloud shadow and other shadows  1 

Grasslands (includes shrubs)     2 

Bare soil       3 

Agricultural land      4 

Asphalt       5 

Urban (includes concrete and tile roofs)   6 

Clouds (includes metal roofs)     7 

 

• After all the points were collected and recorded (250 points) an error analysis was 

performed (Table 12).  
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Table 12 Error matrix table analyzing the user’s accuracy (commission error) and producer’s accuracy (omission error) of land 
cover classification by Erdas Imagine 9.1 of random points  
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A.6 Descriptive Evaluation of Error Matrices 

The overall accuracy of the classification map is determined by dividing the total correct 

pixels (sum of the major diagonal) by the total number of pixels in the error matrix (N). 

Computing the accuracy of individual categories, however, is more complex because the 

analysis has the choice of dividing the number of correct pixels in the category by the 

total number of pixels in the corresponding row or column. Traditionally, the total 

number of correct pixels in a category is divided by the total number of pixels of that 

category as derived from the reference data (i.e., the column total). This statistic indicates 

the probability of a reference pixel being correctly classified and is a measure of omission 

error. This statistic is called the producer’s accuracy because the producer (analyst) of 

the classification is interested in how well a certain area can be classified. If the total 

number of correct pixels in a category is divided by the total number of pixels that were 

actually classified in that category, the result is a measure of commission error. This 

measure, called the user’s accuracy or reliability, is a probability that a pixel classified on 

the map actually represents that category on the ground (Story and Congalton, 1986) 

 

Sometimes we are producers of classification maps and sometimes we are users. 

Therefore, we should always report all three accuracy measures: overall accuracy, 

producer’s accuracy, and user’s accuracy, because we never know how the classification 

will be used (Felix and Binney, 1989).  
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In this study, as presented in the previous results table, the overall classification accuracy 

is 85.60% which is quite good.  It is important to note, however that the producer’s 

accuracy and users’s accuracy are different. For example, the producer’s accuracy of the 

result values of the tree class is 100% which is an excellent result. The user’s accuracy 

value of the same class is 90.32%, which is also quite good, but a little different.   

 

The producer’s accuracy was calculated by dividing the total number of correct pixels in 

the category (28) by the total number of tree pixels as indicated in the main image or 

reference map (28). In this case it can be concluded that because the overall accuracy is 

85.60% and the producer’s accuracy of the tree class is 100%, the procedure and the data 

used are adequate for identifying trees or forest land. It is important not to forget the 

user’s accuracy, which was computed by dividing the total number of correct pixels in 

the tree category (28) by the total number of pixels classified as tree (31), yielding 

90.32%. In other words, although 100% of tree pixels were correctly identified as tree 

class, only 90.32% of the areas called tree are actually tree land.  

 

A careful evaluation of the error matrix also reveals that there was confusion when 

discriminating tree lands and grasslands (and shrub) land cover. However, while they are 

different values, both producer and user’s classification are relatively highly accurate.  

 

On the other hand, a less accurate value is found in the urban (including concrete) 

classification. The producer’s classification value is 80.00% and the user’s classification 
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value is 60.00%.  In both cases, for concrete and urban areas class, the values are under 

the overall accuracy which means less accurate classification. In other words the actual 

site, according to the user’s classification map, would be 60% concrete-urban area, 20% 

bare soil, 15% agriculture land, and 5% others (cover by cloud in the image).   

 

A.7 Kappa Analysis 

Kappa Analysis is the discrete multivariate technique used in accuracy assessment 

(Congalton and Mead, 1983; Feinstein, 1988; Foody, 2002). The method was introduced 

to the remote sensing community in 1981 and was first published in remote sensing 

journal in 1983 (Congalton et al., 1983; Jensen, 2005)  

 

Khat Coefficient of Agreement: Kappa analysis yields a statistic, K, which is an estimate 

of kappa. It is a measure of agreement or accuracy between the remote sensing-derived 

classification map and the reference data as indicated by a) the major diagonal and b) the 

change agreement, which is indicated by the row and column totals (referred to as 

marginals) (Rosenfield and Fitzpatrick-Lins, 1986; Congalton 1991; Paine and Kiser, 

2003). K is computed: 
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Where k is the number of rows, (e.g. land-cover classes) in the matrix, xii is the number 

of observations in the row i and column i, and xi+ and x+i  are the marginal totals for row i 

and column i respectively, and N is the total number of observations.  

 

K values > 0.80 (i.e., > 80%) represent strong agreement or accuracy between the 

classification map and the ground reference information. K values between 0.40 and 0.80 

(i.e., 40 to 80%) represent moderate agreement. K values < 0.40 (i.e., <40%) represent 

poor agreement (Landis and Koch, 1977).  

 
The K value for the study is shown in the next step: 
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The results for the overall classification accuracy (85.60%) and the K statistic (81%) are 

a little different. That is because the two measures used different procedures and different 

information. The first one used only the major diagonal and excluded the omission and 

commission errors. On the other hand the K statistic method incorporated the off-

diagonal elements as a product of the row and column marginal. Therefore, depending on 

the amount of error included in the matrix these two measures may not coincide as in this 

study.  

 

According to the results obtained from this matrix error process, the overall accuracy of 

85.60% and K statistic 81%, values represent a strong agreement or accuracy between the 

classification map and the ground reference information given by the main image, ground 

control points and hardcopy maps. 
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APPENDIX B: DETAILED AGWA 2.0 – SWAT MODELING PROCE DURE 
 
 
The modeling procedures used in this study were developed based on the procedures 

presented in the tutorial 1 from Introduction to AGWA 2.0, The Automated Geospatial 

Watershed Assessment Tool. The tutorial for AGWA 2.0 is found at the website: 

http://www.tucson.ars.ag.gov/agwa/. 

B.1 Watershed Delineation 

Watershed delineation is the first step in the process of using the AGWA2 tool. This is 

used for both KINEROS and SWAT. This step requires entering the basic data types 

(described in File Management>Required Files and Datasets) that are required to 

compute the watershed boundary and then dividing the watershed into a series of planes 

or subwatersheds. This step generates a new watershed outline from a user-specified 

outlet. The resulting Delineator (Figure 45) dialog box is below.  

 

 
Figure 45 Delineator dialog box generated by AGWA 2.0 – SWAT  
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The procedure starts by selecting the GWA2 Tools> Delineation Options> Delineate a 

new watershed. The delineation process involves three steps: 

 

Step 1: Output Location, in this step is defined the location of the workspace, 

which has to be inside the AGWA2 file, and the name of the Geodatabase (cus1) 

 

Step2: Input Grids. This step requires the use of the GRID or Raster data, which 

represent the surfaces characteristics. The grids are: digital elevation model 

(cus_dem), flow direction grid (cus_fdg) and flow accumulation grid (cus_facg). 

Those files were previously described in chapter V, section 5.2.3. 

 

Step 3: Outlet Identification. This step requires the identification of the outlet 

point, by selecting the outlet name in the Point Theme dialog box and then using 

the select point tool to identify the outlet point in the map and get the X, Y 

coordinates. Then click on the Delineate button. 

 

The result of this process is the Watershed Delineation Map (Figure 46). This map 

presents the border of the study area watershed where the light green represents 

the study area watershed and the light to dark gray background is the Digital 

Elevation Model (DEM). The Watershed Discretization Map (Figure 46) shows 

the borders of the subwatersheds, Hydrologic Response Units (HRU), in the study 

area watershed, the process for which is described below. 
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Figure 46 Delineation and discretization maps of the study area watershed generated by 
AGWA 2.0 - SWAT 
 

B.2 Watershed Discretization 

This process subdivides the delineated watershed into model elements, the result of 

which is shown above. The procedure was started by selecting the AGWA2 Tools> 

Discretization Options> Discretize watershed (Figure 47). 
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Figure 47  AGWA 2.0 – SWAT discretizer dialog box 
 

Step 1: Input. The delineated watershed (cus1/cus1), (geodatabase name/ 

delineation name) is selected. 

 

Step2: Model Option. In this step the SWAT option was selected because of the 

type of research in this project. 

 

Step 3: Contributing Source Area (CSA). This value determines the level of 

geometric complexity in the discretized watershed (Figure 15). It is the threshold 

at which flow becomes channelized. Lower CSAs produce more watershed 

elements; higher CSAs, fewer elements. The default value is 2.5%, which 

produced the best results during preliminary analysis. Hectare was selected as the 

CSA unit and 200 as the CSA.  
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Step 4: Output. The final step was to write an output name (s1d1) and click on 

Discretize button. 

 

B.3 Watershed Parameterization 

Before running KINEROS or SWAT simulations for a watershed, hydrologic parameters 

must be derived from the topography as well as the land cover and soils data. Each model 

requires a different set of parameters. Land cover datasets must be in GRID format; soil 

datasets must be in vector format. This step parameterizes model elements based on 

element topography and land cover and soils properties. The following are the two 

parameterization steps in AGWA2 (AGWA2 tutorial).  

Step 1: Element Parameterization. This step begins by selecting the GWA2 

Tools> Parameterization Options> Element Parameterizer (Figure.48). Then 

select the delineated watershed (cus1/cus1), (geodatabase name/delineation 

name). In this case, the default Hydraulic Geometry Options was used. Then click 

on Process button. 

 

 
 

Figure 48 AGWA 2.0-SWAT Element Parameterizer box 
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No matter which model the watershed is discretized for, the user can alter the 

hydraulic geometry relationship used to calculate channel geometries. 

Additionally, the user may create new relationships and store them in the 

HGR.dbf file and recalculate the hydraulic geometry without performing the full 

element parameterization. 

 

Step 2: Land Cover and Soils Parameterization. This step begins by selecting 

the GWA2 Tools> Parameterization Options> Land Cover and Soil 

Parameterization (Figure 49). Then select the delineated watershed (cus1/cus1), 

(geodatabase name/ delineation name) in the watershed option. Then select 

cu_nalc02 for Land cover grid and nalc_lut for the Lookup table option. Then 

click the Continue button. 

 

  
 

Figure 49 AGWA 2.0 – SWAT Land Cover and Soils parameterizer dialog boxes 
 

At this point the watershed has been subdivided into model elements. These elements 

have been characterized according to their hydraulic geometry, flow length, land cover, 

and soil properties. AGWA2 has added a few items to the attribute table of the 
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subwatersheds and streams layers that will be used to provide input to the SWAT model. 

These changes can be seen by right-clicking the subwatersheds or streams theme in the 

list of layers and selecting Open Attribute Table. 

 

This process described above is necessary in order for AGWA 2.0 to prepare the 

information it needs to continue. Table 13 displays the attributes for the 32 subwatersheds 

and Table 14 displays the attributes for the 31 streams. The most important subwatershed 

information is: shape length, shape area, mean elevation, average slope, and curve 

number (CN). The most important stream information is: shape length, SWAT id, 

average slope, and depth. 
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Table 13 Attributes table of the 32 subwatersheds in the study area watershed 
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Table 14 Attributes table of the 31 streams in the study area watershed  
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B.4 Prepare rainfall files 

AGWA 2.0 generates precipitation files for SWAT using a single gage, uniform method, 

or a multiple gage, distributed method. The multiple gage method utilizes Thiessen 

polygons to create an area-weighted precipitation file. Precipitation estimates (and 

temperature estimates) can be adjusted for topography with the SWAT elevation band 

component for individual watersheds. 

 

To generate a uniform rainfall data first open AGWA2 tools> Precipitation Options> 

Write SWAT precipitation to obtain the SWAT Precipitation Step 1 dialog box (Figure 

50). Then continue by selecting the delineated watershed (cus1/cus1), (geodatabase 

name/ delineation name). Then select the rain gage input and the STATION_ID as the 

rain gage ID field. The number of the rain gage (846860) will show up in the selected 

gage dialog box. Then identify the location point of the rain gage in the map, by using the 

select point tool. Then click on Continue button (AGWA2 Tutorial). 
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Figure 50 AGWA 2.0 – SWAT Precipitation Step 1 input box 
 

The SWAT Uniform Precipitation box (Figure 51) popped up with the precipitation file 

characteristics.  Then the unweighted precipitation file (cu_pre85_05) was selected and 

given name (P846860) for the precipitation file. The process finished by clicking the 

Write button.  
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Figure 51 AGWA 2.0 – SWAT Uniform precipitation input dialog box 
 
 
The generated precipitation file is then saved in a separate folder (Figure 52) 

 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 52 Location map of AGWA 2.0 – SWAT precipitation folder 
 

B.5 Model Execution 

The watershed has been delineated, discretized, and parameterized and rainfall files 

created. The next step is writing the model input files and running the model. AGWA 

loops through the attributes of the selected watershed discretization and creates text files 
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used to run the model. Once the text files are written, a call is made to a command 

window to execute the model.  

 

This step begins by selecting the AGWA2 Tools> Simulation Options> Run SWAT. 

Then select watershed (cus1/cus1d1), (geodatabase name/ delineation name) in the 

watershed option (Figure 53). Then in the Climate inputs select precipitation file 

(P846860) and for temperature Use Observed Temperature Data 

(Mod_cus\AGWA2\datafiles\precip\cu82_02.tmp). For the weather generator file 

z(WGN) wgn_cu03 was selected. Then for the simulation inputs 20 years simulation was 

selected and si1cu1 as the name of the simulation. Then click on write button to run the 

model.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 53 AGWA 2.0 – SWAT Input Files boxes for climate and simulation inputs 
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A MS-DOS windows box (Figure 54) opened showing the program running with 20 

years simulation. 

 

 
 

Figure 54 MS DOS AGWA 2.0 – SWAT program running window 
 

B.6 Results 

After SWAT runs to completion, the SWAT output files must be imported into AGWA2 

before displaying the spatially distributed results, such as runoff, infiltration, and other 

water balance results (AGWA2 Tutorial). For viewing the results first click AGWA2 

tools> View Results> view SWAT Results (Figure 55). 
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Figure 55 AGWA 2.0 – SWAT Results output dialog box 
 

Several options are available for viewing the results. All simulations can be viewed with 

the standard outputs on the Results Selection panel. Select an output type and click 

Update to view the simulation totals. Chapter V contains the resulting tables and maps for 

Model 1.  
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